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Unified Classroom: Grading 
This workbook is intended as a guide for users new to both PowerSchool Unified Classroom 
and PowerSchool's gradebook, PowerTeacher Pro (PTP), and as a reference for users new to 
Unified Classroom, but familiar with PTP. Become familiar with Unified Classroom navigation 
and how the tools help you stay informed about student needs and progress. Discover how 
to use this robust classroom management tool that includes advanced features for both 
standards-based and traditional grading. 

Getting Started 
Use PowerSchool Unified Classroom to sign in to all of your PowerSchool products with a 
single account. There’s no need to launch a separate application to access PowerTeacher, 
PowerTeacher Pro, Learning, or other teacher tools. Navigate to Unified Classroom by 
entering your server address in a web browser.  

Create a unique PowerSchool ID to sign in to Unified Classroom. Make sure you securely 
record the Unified Classroom URL, your username, and password you create for the next 
time you sign in. Once created, your PowerSchool ID will be used to access all of your 
PowerSchool systems.  

Take the following steps to create a PowerSchool ID: 

1. In a web browser, enter your teacher portal URL 
 
You will be redirected to the Unified Classroom Sign In page. 

2. Click Create PowerSchool ID at the bottom of the page 
 

 
3. Enter your current PowerSchool SIS username 

4. Enter your current PowerSchool SIS password 
 
Before you can get a new PowerSchool ID, you must validate your existing 
PowerSchool username. 

5. Click Sign In 

6. Click Continue 

7. Enter your email address as your PowerSchool ID username 
 
Use your school or school district email address. 
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8. Enter a password 
 
Your new password must be unique, must contain more than eight characters, and 
cannot contain more than three repeating characters. 

9. Click Create PowerSchool ID 

10. Click Continue to Unified Classroom Sign In 

Once you have created a PowerSchool ID, to sign in to PowerSchool Unified Classroom: 

1. Enter the URL of your Unified Classroom site 

2. Enter your PowerSchool ID and password 

3. Click Sign In 

 
To sign out of PowerSchool Unified Classroom: 

1. Click the user menu at the bottom of the navigation menu 

2. Click Sign Out 

Beginning Your Year with Unified Classroom 
As a teacher, once you sign in to Unified Classroom, you immediately have information at 
your fingertips that influences the course of your day. Access student information easily and 
work with a class of students or with one student at a time. 

Adjust lesson plans and activities as needed based on information about school-wide events, 
class activities, current assignments, and current standards mastery and academic 
progress. 
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Understanding Dashboard Navigation 
The first page you see in Unified Classroom is called the Dashboard. The left navigation 
menu, outlined in red in the image below, lists all of the Unified Classroom resources 
available to you. Clicking a link will either take you to that page or open another menu of 
additional pages. At the top of the navigation menu is the PowerSchool Unified Classroom 
logo. This logo is a link, and clicking the logo returns you to the Dashboard from most pages 
within Unified Classroom. 

In the center of the page, outlined in green, is the class selector menu. Click the class 
selector menu to open it. From this menu, select the class or class groups you wish to work 
with. Class groups include all of your classes, or all of your similar sections, such as all 
Biology classes. When the class selector menu is open, you also have access to change the 
school year you are working in and the scheduling term. Click the options icon (the icon that 
looks like three dots) in the upper-right corner of a class tile to open the Attendance page 
for a class that is not in session, the Seating Chart page, or the Scoresheet. 

The icons in the top-right corner of the Dashboard include the term menu, the create icon 
and menu, and the notifications, help, and search icons. They are outlined in blue. The 
user’s name, outlined in yellow, is called the user menu. 

The Dashboard also provides easy access to the calendar, recent assignments, traditional 
and standards information, and the activity feed. 

Unified Classroom Dashboard 

 
 

Use these Unified Classroom icons to complete navigational tasks: 
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Icon Definition 

 

Click the Unified Classroom logo to return to the 
Dashboard from other pages 

 

Open the class selector menu to select the class or 
class group you wish to work with 

 

Use the Term menu to select the term 

 

Click the create icon, which looks like a + sign, to 
add assignments, and use the create menu to 
select defaults for new assignments and Learning 
pages 

 

Click the notification icon to view new system 
notifications 

 

Click the help icon to access the Help Center with 
step-by-step directions, videos, and workbooks, 
and to access FAQs, Live Assist, and to create a 
new Support case 

 

Click the search icon to quickly find a student, 
links to pages within Unified Classroom, and 
favorites 

 

Click your name at the bottom of the navigation 
menu to open the user menu and access your 
profile, update settings, and to sign out 

 

The Recent Assignment icons include, from left to 
right: the assignment details icon, the view 
attachments icon, the view scores icon, and the 
edit icon 

Working with a Group of Students 
To work with a class of students, first select the class from the class selector menu. Next, 
click Students in the navigation menu. 



Unified Classroom: Grading 
 

Copyright © 2018 PowerSchool Group, LLC or its affiliates. All rights reserved. 6 

Check for early warning alerts within the student tile to see if a student has a failing grade, 
a high number of absences or tardies, missing assignments, or a combination of these 
issues.  

• If the student has a grade warning (defined by a color level orange or red in the 
grade scale), the letter grade and percentage appears in red 

• If the student has missing assignments, a question mark and the number of missing 
assignments appears in red 

• If the student is absent today, "Abs" appears in red 

 
Click Filter to search for a specific student. Click Select and then click the students to pick 
a specific group of student names. Click X to close the selection screen. 

Using Quick Links 

When you’re working with a class or group of students, quickly access multiple product 
pages from within PowerSchool Unified Classroom. Use Quick Links to access features such 
as a link to recommendations, the daily bulletin, and the staff directory. Links are also 
available for custom pages if your district has enabled custom content. 

To navigate to a quick link, click the name of the link. A new tab will open in your web 
browser. When you finish working in that area, close the tab and select the Unified 
Classroom tab to return to Unified Classroom. 
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Working with One Student 
There are several ways to view an individual student. One option is to click the Search icon 
in the top-right corner of the Dashboard. Enter the student's last name in the Search field. 
Click the student's name to open the Student Detail page. 

Another option is to click Students from the navigation menu and roll your cursor over the 
student tile of the student you wish to work with. From this point, you have several options. 

1. Click the view icon to open the Student Detail page 

2. Click the Quick Links icon to open the student's Demographics page 

3. Or, on the Students page, click the student’s name to view a window with a quick 
overview of general student information and then click View Detail to go to the 
Student Detail page 

 
On the Student Detail page, the Overview tab displays the student's class overview, 
including the student's current grade, recent assignment information, standards progress, 
and personal information about the selected student. 
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Use the Assignments tab to view the assignments this student has been assigned. Click an 
individual assignment to view details on the student's performance on the assignment. Click 
Edit Scores to modify an assignment grade. 

Use the Quick Links tab to access additional student pages such as Graduation Plan 
Progress, Recommendations, and Student Assessment Results. 

 

Review a Student’s Information and Edit a Score 

View a student's personal alerts and then edit an assignment score. 

1. Open the class selector menu and choose an academic class  

2. On the Dashboard, click Students 

3. Move your cursor over a student tile and click the view icon (eye icon) to open the 
Student Detail page 

4. In the Personal Info section, click View 

5. After reading the alerts associated to this student, click Close 

6. Click Assignments 

7. In the Recent Assignments area, click Edit Scores 

8. Click a grade in the Score column next to the assignment you wish to modify 

9. Use the Score Inspector to enter the new score 

10. Click Save 
 
In some cases you will receive a message asking whether you wish to keep or adjust 
existing standards scores. Select either Adjust Scores or Keep Scores. 
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Viewing Individual Student Standard Progress 

To review an individual student’s performance: 

1. Click Students from the navigation menu 

2. Select the view icon for a student to open the Student Detail page 

3. In the Standards Progress area, click Edit Grades 

4. Review the student’s standards scores for each reporting term, then click the 
Assignments icon for one of the standards 

5. Review the graph of standards scores, then click Show Metrics to review the 
student’s other standards statistics 
 

 
Here are the definitions of the standards scores statistics that are visible when you click 
Show Metrics below the graph: 

• Most Recent – The average of the most recent score(s) 

• Mean – The mathematical average of the scores 

• Median – The middle of the scores (half of the scores are above this number and half 
are below) 

• Mode – The most common score achieved 

• Weighted Mean – The average of the scores based on the average of total weighted 
points 

• Highest – The highest score 

These statistical values are indicators of how well the student did on a specific standard. If 
any of the values are low, it may mean that the student needs additional practice on the 
skill or concept that you’re assessing, or you may need to revise the assignment. To view 
the student’s performance on additional standards, open the Quick Menu and select a 
standard. 

The orange Professional Judgment Indicator may appear next to a student’s standard score 
on the Standards Progress page when evidence exists for mastery that may differ from the 
student’s calculated standard score. To evaluate the student’s level of mastery, click the 
Assignments icon next to the standard score. 
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Use your professional judgment to evaluate whether or not the calculated score is a true 
indication of the student’s level of mastery. For example, if the student was ill or had a bad 
test day, his last score may not be a true indicator of his skill level, so you could choose to 
ignore that score and change the calculated score from a 2- to a 2. 

Graphing Additional Standards or Metrics 

To compare a student’s progress on up to four standards: 

1. Click the Gear icon next to the term menu on the Standards Progress page  

2. Click Progress Options  

3. In the Progress Options window, select the standards you want to include in the 
comparison and click OK 

4. Then, click the Show/Hide Graphs icon next to the Gear icon to view the student’s 
progress on all of the selected standards  

5. Click one of the symbols, such as a triangle, on one of the line graphs for a different 
standard to highlight it and view the scores 

6. Below the graph, view the calculated standard grades, the metrics, the aligned 
assignments, and the scores for the standards included in the comparison 
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By default, the Standards Progress graph displays a green dotted line that corresponds to 
the metric, such as Most Recent, used in the standards grade calculation.  

To add additional metrics to the graph: 

1. Click the Gear icon next to the term menu on the Standards Progress page  

2. Click Progress Options  

3. In the Progress Options window, open the "Additional Metric To Graph" menu and 
select a metric, such as Highest 

4. Click OK 
 
A gray dotted line appears on the graph, indicating the score that corresponds to the 
selected metric. 

 

Viewing Additional Student Pages 

Once you are working with a student, you can use the student view menu next to the 
student's name to access additional pages. This menu can also be used to select a different 
student in the class to work with. 
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The individual student pages provide helpful grade and personal information. The following 
table provides brief descriptions of the pages and their purposes: 

Student View Page Description 

Assignments Use the Assignments page to view a summary of a student’s 
grades and assignments for the selected reporting term. The 
Assignments student page is similar to the Assignments page 
you view for the entire class, except that it shows only the 
assignments and scores for the selected student. 

Standards Progress The Standards Progress page shows a student’s standards 
grades by reporting term. The column that corresponds to the 
current term is highlighted. Compare the grades the student 
received in each term to assess his or her progress. To view 
the assignments that you used to assess the standard, click 
the icon in the Assignments column. Then use the graph at 
the top of the page to see how the student performed over 
time on the standard. 

Comment Log Use the Comment Log page to view all of the comments 
you’ve recorded for a student. Depending on the types of 
comments you’ve entered for the student, the comment log 
may show course grade comments, standards grades 
comments, and assignment comments. 

Demographics Use the Demographics page to view a student’s personal 
information, such as his date of birth or mother’s phone 
number. 

Quick Lookup - 
Traditional 

The traditional Quick Lookup page is the same page that 
administrators see in PowerSchool. It shows the student’s 
attendance for the last two weeks, his current schedule, his 
term grades, a summary of his total absences and tardies, 
and his current GPA. Click a grade to see the flags (colored 
icons or indicators that represent common assignment notes 
like “Late” and “Missing”) for the student’s assignments and to 
see the standards score information. Click the Standards icon 
to view the standards aligned to an assignment. 

Quick Lookup - 
Standards 

To view a student’s standards Quick Lookup page, use the 
Quick Lookup - Standards link. Then click the arrow next to 
one of the student’s classes to view the standards aligned to 
the course and the student’s standards final grades. Click a 
standard final grade to view details about it. 

PowerTeacher Portal Use the PowerTeacher Portal link to view the selected 
student’s screens in PowerTeacher. PowerTeacher opens in a 
new window so that you don’t lose your place in Unified 
Classroom. The PowerTeacher screen that appears depends on 
which screen you set up to be the default student screen in 
PowerTeacher. For example, you may see the student’s 
Schedule screen. 
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Handling Daily Classroom Management Tasks 
In the center of the page is the class selector menu. Click the class selector menu to open 
it. From this menu, select the class you wish to work with. A white chair icon represents a 
class that is in session on the current date. Classes that have a grayed-out chair icon are 
not in session. 

 
Click the options icon (the icon that looks like three dots) in the upper-right corner of a 
class tile to open the Attendance page for a class that is not in session, open the Seating 
Chart page, or open the Scoresheet. 

Take Attendance 

To record attendance for a class that is in session: 

1. On the Dashboard page, click the class selector menu  

2. Click the chair icon next to the in-session class for which you want to take 
attendance 

3. On the Record Attendance page, select the appropriate attendance tab to record 
attendance for a single day, multiple days, or using the seating chart 

4. Open the Attendance Code menu and select an attendance code 

5. Click in the Attendance field next to a student's name to add the code 

6. Click Submit 

7. Close the Attendance tab and return to the Unified Classroom tab 

Using the Calendar to Plan Your Day 
Use the Calendar area on the dashboard to quickly review the current events, assignments, 
and personal reminders for the day. Use the next and previous arrows to switch to a 
different date or open the calendar icon to select a different month and year. Click View 
More to view the current date, the week, or the month in a grid format. 

Add events that are viewable by students and parent. Add personal reminders to track your 
tasks and stay organized. 



Unified Classroom: Grading 
 

Copyright © 2018 PowerSchool Group, LLC or its affiliates. All rights reserved. 14 

 

Add an Event to the Calendar 

Use the Events section to track any activities that have the potential to impact your 
classroom, such as an early dismissal. Events are public and viewable in the student and 
parent portals. 

To add an event to your calendar: 

 In the Calendar pane on the Dashboard, click the + sign next to Events 

 For the name of the event, enter Teacher Conferences 

 For the description, enter Please contact me this week to schedule a 
conference for your student. 

 In the Classes section, click the gear icon 

 Click All Classes 

 Click the second calendar icon and enter a date that is a week from today's date  
 
By default, events are set to occur all day. To add specific times for the event, toggle 
the Specific Time setting on. Then enter start and end times for the event in the 
fields that will appear below the date. 

 Click Submit 

Add a Personal Reminder 

Remind yourself of tasks you need to complete by adding notes to the personal reminder 
section. Personal reminders can be seen by only the teacher and are not visible to 
administrators, students, or parents. 

To add a personal reminder to your calendar: 

1. In the Calendar pane, click the + sign next to Personal Reminder 

2. Add a name for the reminder 
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3. Add a description 

4. Determine if the personal reminder will be all day or if you need to indicate a specific 
time frame  
 
By default, reminders are set to occur all day. To add specific times for the personal 
reminder, toggle the Specific Time setting on. Enter the start and end times for the 
reminder below the date. 

5. Click Submit  

Reviewing Student Progress to Drive Your Instruction 
By default, standards and traditional progress information is visible on the Dashboard. Use 
this area to quickly assess if students are meeting required benchmarks. It may be 
necessary to adjust the lesson plan based on this information or create a reminder to meet 
with a few select students who are struggling with particular concepts. Click View All in the 
Standards Progress or Traditional Progress area for further analysis. Click the Unified 
Classroom logo to return to the Dashboard. 

For teachers not using both standards and traditional grades, modify the display settings to 
show only the progress area you use. How to work with display settings is discussed later in 
this document. 
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Checking Assignment Effectiveness  
Use the Recent Assignments area to view the latest class assignments. When you roll your 
cursor over an assignment, the view, score, and edit icons appear. Click the view icon, 
which looks like an eye, to see details about the assignment and open the 
Assignments/Activities page. Click the score icon, which looks like a calculator, to enter 
grades for an assignment. Click the edit icon, which looks like a pencil, to edit assignment 
details. Click View All to see all assignments for the term. 
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Update a Recent Assignment Grade 

To modify a score for a student on a recent assignment: 

1. On the Dashboard, roll your cursor over an assignment in the Recent Assignment 
area 
 
The view, score, and edit icons appear. 

2. Click the score icon  

3. On the Assignments page, locate a student and click in the Score column 
 
The Score Inspector opens. 

4. Using the Score Inspector, modify the grade according to the score type 

5. Click Save Scores 

Evaluating Student Success Using Standards Progress 
Use the Standard Progress page to view standards grades progress for a class or a group of 
your classes. The graph on the Standards Progress page shows the distribution of grades for 
each standard aligned to the course, for the selected class and reporting term. On the 
Dashboard in the Standards area, click View All to open the Standards Progress page. 

Additionally, to view standards grades progress: 

1. From the navigation menu, click Analysis 

2. From the Analysis menu, click Standards Progress 
 
The graph on the Standards Progress page shows the distribution of grades for each 
standard aligned to the course, for the selected class and reporting term. 
 

 
3. Click the graph for one standard to open the Standard Grades Distribution window 

4. On the left side of the Standard Grades Distribution window, view the grade 
distribution for the selected standard for each reporting term in the school year 



Unified Classroom: Grading 
 

Copyright © 2018 PowerSchool Group, LLC or its affiliates. All rights reserved. 18 

5. On the right, view the grade trends of the students in the class for the selected term, 
compared to the previous term 
 
A red arrow in the Grade column indicates that the student’s level of mastery is 
trending down between the selected terms. A green arrow indicates an upward 
trend, while no arrow indicates no change.  

6. To compare trends between a different selection of subsequent terms, click a term in 
the Grade Distribution column 

7. To close the window, click X in the upper-right corner 
 

 
On the right side of the Standards Progress page, the number in the Assignments column 
indicates the number of assignments that you’ve used to give students opportunities to 
practice the standard or to assess their levels of mastery.  

To view the assignments aligned to a standard: 

1. Click the Assignments icon next to a standard 
 

 
2. On the Standards Assignment Trend window, click the name of an assignment 

3. If needed, edit students’ scores in the column for the selected standard and save the 
scores 
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Evaluating Student Success Using Traditional Grading Progress  
On the Dashboard in the Traditional Grades area, click View All to open the Traditional 
Grades Progress page.  

Additionally, to view traditional grades progress: 

1. From the navigation menu, click Analysis 

2. From the Analysis menu, click Traditional Progress 
 
The graph on the Traditional Grades Progress page shows the distribution of grades 
for the class for the selected reporting term. To the right of the graph, view a 
summary of the total number of students who have missing, late, or incomplete 
assignments. To view the grades in each grade scale color level, click the information 
(i) icon. 
 

 
3. Click View All to open the Traditional Grades Distribution window 

4. On the left side of the Traditional Grades Distribution window, view the grade 
distribution for each reporting term in the school year 

5. On the right, view the grade trends of the students in the class for the selected term, 
compared to the previous term 
 
A red arrow in the Grade column indicates that the student’s grade is trending down 
between the selected terms. A green arrow indicates an upward trend, while no 
arrow indicates no change. You can see which students are performing better or 
worse between terms. 

6. To compare trends between a different selection of subsequent terms, click a term in 
the Grade Distribution column 
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7. To close the window, click X in the upper-right corner 
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Generating Encouraging Feedback 
Multiple reports are available in Unified Classroom to enhance the teacher experience and to 
share information with students and parents. The following table provides brief descriptions 
of the reports and their purposes: 

Report Purpose 

Individual Student Report • Use this report to view or print a summary of the 
class activity per student 

• Include only one class or the student's full schedule 

• Include student numbers next to student names for 
identification purposes 

• Use as a summary of student work or as a midterm 
update for students and parents 

• Choose whether or not to include course grades and 
attendance, assignments, category totals, standards 
scores, citizenship scores, and comments 

• Print the report for a few students or a group 

Assignment Report • Use this report to view or print a list of students and 
scores per assignment 

• Use it to find missing, late, or incomplete 
assignments, to help students and parents keep up 
with class work, to target students who need extra 
help, or to gauge which assignments present the 
most challenges to students 

Scoresheet Report • Use this report to print a copy of the Scoresheet 
page 

• Include final grades and assignment scores 

• Use student numbers or names and sort students by 
name, student number, or randomly 

• Use it to post a printout of students' grades 

• Run the report as a PDF or an Excel spreadsheet 

Student Roster • Use this report to view or print demographic 
information by class 

• Use the report to keep track of money collected for 
classroom field trips, or as an emergency contact 
list, for example 

• Customize the report by adding blank columns (the 
report retains the information you entered last) 

• Use the Order arrows to arrange the columns in any 
order 

• Run the report as a PDF or an Excel spreadsheet 
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Follow these steps to run teacher reports: 

1. From the navigation menu, click Analysis 

2. Click Reports 

3. Select a report, such as Assignment Report 

4. Enter the report options on the Criteria, Students, and Format tabs 

5. Click Run Report 
 
Based on how your computer settings are configured, the reports will download in a 
PDF or Excel format, based on your selections. 

Create Progress Reports 

Next week you have parent-teacher conferences for your struggling students. You've 
already analyzed grades and identified the students who need parent-teacher conferences. 
Now, prepare for the meeting by creating progress reports that you can give to parents for 
their records. 

1. Click Analysis 

2. Click Reports 

3. Select Individual Student Report 

4. Enter a report title, such as Progress Report 

5. Open the Classes menu and choose the classes to include on the report 
 
Click outside of the menu to close it. 
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6. You don't want to print custom class names on the progress reports for parents, so 
verify that the Use Custom Class Name check box is not selected 

7. Since the progress reports are for your classes only, rather than for all of the 
students' classes, verify that the Use Student's Full Schedule check box is not 
selected 

8. To generate each student's report as a separate file, check Separate Report By 
Section, By Student  

9. In the Sort Options section, open the Layout menu and choose By Section, By 
Student 

10. To sort the report by students’ last names, open the Students menu and choose Last 
Name 
 
To use the preference for how student names are sorted by default in your 
gradebook that you defined under user menu > Settings > Display Settings, choose 
Gradebook Preference. 

11. Use the Assignments menu to sort the assignments by due date or by category and 
due date; for example, choose Due Date (Newest First) to list the assignments by 
the most recent due dates 

12. Open the Areas to Include menu and check Course Grade Comments and 
Assignment Comments to include any comments you’ve entered about the 
students in the report 
 
"Course Grades and Attendance," Standards Final Grades, Assignments, and 
Category Totals are checked by default. If citizenship score entry is enabled, select 
Citizenship to include citizenship scores. 

13. Click the Areas to Include menu again to close it 

14. Verify that Show Percentages is selected to include students’ grade percentages in 
the report 

15. To include any assignments that have no grade data, such as those that haven't 
been scored yet, check Show Assignments with no Data 

16. To include the standards identifiers for standards final grades, check Include 
Standards Identifier 

17. To help with identifying students with the same name, add student numbers next to 
student names in the report header by selecting Include Student Number with 
Student Name 

18. To include students’ grades, assignments, and category totals from the current term, 
use the default settings under Date Range 

19. Use the default settings under Data Filters to include any assignments, any scores, 
any category, and any course grades 

20. Scroll to the top of the page and click the Students tab 

21. To run the report for a selection of students rather than for all of the students in the 
classes, click Add/Remove Students 
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22. All of the students are selected by default, so clear the check box to the right of the 
Filter area, then in the list of students, check the boxes next to the struggling 
students’ names 
 
For the purposes of this activity, pick a few students at random. 

23. Scroll to the top of the page and click the Format tab 

24. Since you are including all of the available data in the report, leave the page 
orientation set to Landscape to make the text easier to read 

25. Use the default option PDF for the report output 

26. To create a page break between students, check Page Break 

27. Choose to exclude row shading to save ink during printing 

28. Leave the “Include” check box clear for the Top Note option, since you don’t plan to 
include a note at the top of the report 

29. Since you are meeting the student’s parents in person, you don't need a signature 
line, so also leave the “Include” check box clear for the Bottom Note option 

30. To generate the report, click Run Report 
 
Depending on how your computer is configured, the report will be saved as a 
download or it will open in your browser. The report may also be downloaded as a 
zipped file. Now you can print the reports to share them with parents. 

Run a Student Roster Report 

In the middle of the term, you take your students on an annual field trip to the local art 
museum. Use the Student Roster report to take attendance and to keep track of student 
participation during the field trip. 

1. Open the menu at the top of the gradebook window and select the class 

2. Click Analysis 

3. Click Reports 

4. Select Student Roster 

5. Enter a report title, such as Field Trip Roster 

6. Since you selected a class before you navigated to the Reports menu, it is already 
selected for the Classes option 

7. If you've customized the names of your classes and want to use the custom names 
in the report, check Use Custom Class Name 

8. To sort the roster of students by last name, open the Students menu and choose 
Last Name 

9. Add columns of student information by opening the Add Columns menu and clicking 
Add next to Gender and Grade Level 

10. Click Add next to Blank twice to include a column for taking attendance and one for 
tracking participation 
 
A column titled “Name” is included by default to list the students’ names. 
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11. Click the Add Columns menu again to close it 

12. Enter Attendance as the title of the first blank column 

13. Enter Participation as the title of the second blank column 

14. Scroll to the top of the page and click the Students tab 

15. Verify that the report applies to all of the students in the selected class 

16. Scroll to the top of the page and click the Format tab 

17. Open the Orientation menu and choose Portrait 

18. Use the default option PDF for the report output 
 
To work with the data in a spreadsheet, choose Excel. 

19. Use the default settings for the rest of the format options 

20. To generate the report, click Run Report 
 
Depending on how your computer is configured, the report will be saved as a 
download or it will open in your browser. Now you can print the report and take it 
with you on the field trip. 

Run the Scoresheet Report 

To analyze your students' grades, you like to export their assignment scores and final 
grades so that you can work with the data in a spreadsheet. Use the Scoresheet report to 
generate a summary of your students' Semester 2 grade data in Excel. 

1. Verify that you are working in the S2 term 

2. Click Analysis 

3. Click Reports 

4. Select Scoresheet Report 

5. Enter a report title, such as S2 Scoresheet 

6. Open the Classes menu and choose the classes to include on the report 
 
Click outside of the menu to close it. 

7. If you've customized the names of your classes and want to use the custom names 
in the report, check Use Custom Class Name 

8. To see your students' names in the report, instead of their student numbers, open 
the Student Field menu and select Student Name 

9. You typically view your class rosters in the gradebook by students' last names, so 
sort them the same way in the report by opening the Students menu and selecting 
Last Name 

10. You want to see your students' grades in all assignment categories, so use the 
default setting of Any Category for the Categories menu 

11. Verify that the Final Grades and Date Range menus are set to S2 since you want to 
include students' grades from the entire Semester 2 reporting term 
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12. All of the students in the selected classes are included by default, so skip the 
Students tab and click the Format tab instead 

13. Open the Orientation menu and choose Landscape 

14. To generate the report as a spreadsheet, open the Output menu and select Excel 

15. Use the default values for the rest of the settings and click Run Report 
 
Depending on how your browser settings are configured, the report will be saved as 
a download or it will open in your browser. Now you can work with your students' 
grade data in a spreadsheet. 

Run the Assignment Report 

Before the end of the Semester 2 term, you want to give your students a chance to turn in 
any missing or incomplete assignments. Use the Assignment Report to create a printout that 
you can post for students so that they can take advantage of the opportunity to complete 
the assignments. List students by their student numbers to maintain privacy. 

1. Click Analysis 

2. Click Reports 

3. Select Assignment Report 

4. Enter a report title, such as Missing and Incomplete Assignments 

5. Open the Classes menu and choose the classes to include on the report 
 
Click outside of the menu to close it. 

6. To list students by their student numbers instead of their names in the report, open 
the Students menu and select Student Number 

7. To sort the assignments by the most recent due dates first, open the Assignments 
menu and select Due Date (Newest First) 

8. Under Data, clear the Show Percentages and Show Assignment Comments 
check boxes 
 
Check Show Assignments with no Data to include students who have no score 
entered for an assignment. 

9. Verify that S2 is selected in the Assignment Date Range menu 

10. To limit the report to include only missing and incomplete assignments, open the 
Assignment Attributes menu and check Missing and Incomplete 
 
Click outside of the menu to close it. 

11. You don't want to limit the assignments included in the report by a grade range or by 
specific grades, so use the default setting of Any Scores for the Assignment Scores 
menu 
 
If an assignment score filter is already set, open the Assignment Scores menu and 
select No Filter. 
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12. Similarly, you don't want to limit the assignments included in the report by a specific 
category, so use the default setting of Any Category for the Assignment Categories 
menu 

13. All of the students in the selected classes are included by default, so skip the 
Students tab and click the Format tab instead 

14. Open the Orientation menu and choose Landscape 

15. To generate the report as a printout, open the Output menu and select PDF 

16. To create a page break between classes, check Page Break 

17. To include a message at the top of the report for your students, check Include next 
to Top Note and enter a message, such as All missing and incomplete 
assignments are due for partial credit by Friday 

18. Use the default values for the rest of the settings and click Run Report 
 
Depending on how your computer is configured, the report will be saved as a 
download or it will open in your browser. Print the report and post it for your 
students in the classroom. 

Creating Assignments to Assess Student Knowledge 
Before you begin creating assignments, it’s recommended that you review district created 
categories and create new categories so that you can group assignments by type. Then, set 
up assignments, choose whether or not to include them in students' final grades, and tie 
them to standards. Once you've created assignments, learn how to duplicate an assignment 
and how to copy assignments to another class or term. 

Adding Categories to Organize Assignments 
Categories are broad classifications in which you group similar types of assignments. 
Examples of categories are homework, tests, and quizzes. Set up your own categories or 
use district-created categories. District-created categories are identified by an icon that 
looks like a school house next to the category name. 

Make a category available to one, some, or all of your classes. For example, if you teach 
two lab sections, you can create a category for lab work assignments and make the 
category available for use in only those two sections. When you create assignments for 
other classes, you will not see the lab work category in the list of available categories. 

Your district leaders may create categories for teachers to use. Teachers cannot delete 
district-created categories, but if school policy requires you to use your own categories, or if 
you do not want to use district-created categories, you can make them inactive. 
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Category Considerations for Co-teachers  

If a pair of teachers share a teaching assignment in which one teacher is the lead teacher 
for some sections and her partner is the lead in others, categories will work somewhat 
differently for them. When a teacher creates a category, it is tied to the teacher’s record in 
the PowerTeacher database. In the case of co-teaching, it is tied to the lead teacher’s 
record. If the co-teacher creates a new assignment and chooses one of her own unique 
categories, Unified Classroom will prompt her to select one of the lead teacher’s categories 
instead. 

Using Score Types 

Choose from four different score types in the gradebook—points, percent, grade scale, or 
collected only. It's possible to use one score type for one category and a different type for 
another, but it’s best to choose one method and use it consistently when scoring 
assignments so that reviewing and analyzing student performance is easier. When assigning 
specific score types to a category or assignment, choose from the following scoring options: 

• Points – Record all scores as points 

o Examples: 25 out of 25, 8 out of 10, 50 out of 100 

• Percent – Record all scores as percentage values 

o Examples: 100%, 80%, 50% 

• Letter – Record all scores as letter values 

o Examples: A, B, F 

• Number – Record all scores as numeric values 

o Examples: 4, 3, 1 

• Grade Scale – Record all scores as values from the grade scales 

o Examples: A, B, F, or 4, 3, 1 

• Collected Only – Record all scores using the collected score indicator 

o Examples: Ö 

The name of the score type will change based on the underlying grade scale. Letter grade 
and Numeric grade are the norm. However, if multiple sections are selected with multiple 
grade scale types, the option changes to Grade Scale. 
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Once you have set the way scores are to appear in each category, any assignment you 
create uses that format by default. You can change the default setting when you create 
individual assignments. Making a decision in advance for categories in general simplifies 
your gradebook work in the long term. 

Modify a District Category and Create a New Category 

Make the district category Classwork inactive and create a new assignment category for all 
classes called Pre-Test. 

1. Click Grading 

2. Click Categories 

3. In the Classwork row, click the edit icon 

4. Change the status to Inactive 

5. Click Save 

6. Click + Category 

7. New categories are available to all classes by default, so enter Pre-Test as the name 
of the category  
 
To limit the category to a smaller selection of classes, you would choose the classes 
from the Select Classes menu. 

8. Select a color for the category, such as Red 

9. Use the default status of Active 

10. Enter a description of the category, such as Use for pre-test assignments 

11. Click the Assignment Defaults tab 

12. Select the default score type that assignments in this category will use, such as 
Points 

13. In the Score Entry Points field, enter the number of points that assignments in this 
category will be worth by default, such as 100 

14. Use the default value Immediately in the Publish Assignment menu to define when 
assignments in this category will be published 

15. To publish the scores of assignments in this category by default, verify that Publish 
Scores is selected 

16. Exclude assignments in this category from final grade calculations by clearing the 
Count in Final Grade check box 

17. To save the new category, click Save 
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Creating and Viewing Assignments 
View assignments on the Dashboard and on the Assignments/Activities and Scoresheet 
pages. Set up assignments at the beginning of a school term or at any time during the 
term. Create a new assignment by clicking the create icon, which looks like a + sign. By 
default, the currently selected class is the one the assignment is made available to, but you 
have the option of adding additional classes while creating the assignment. Create new 
assignments or base assignments on assessment questions created in the assessment 
library. Choose to allow students to submit work online.  

All assignments require a name, a category, a score type, and a due date. Make the 
assignment available to a specific group of students by opening the Students tab and 
selecting students from the list displayed on the Add/Remove Students subtab. Align 
standards, if desired, and define when and whether to publish the assignment and 
assignment scores. To save time, duplicate existing assignments or create duplicates while 
creating a new assignment. 

On the Assignments/Activities page is a list of assignments for the selected class and 
selected term. The list displays the assignment categories, their names, and due dates. In 
the next column, view how many students have submitted work and marked it as done. 
Students can upload their work or mark an assignment as done anywhere they see 
assignment information in Unified Classroom. Teachers can quickly see how many students 
have completed or uploaded assignment work, view a student's work directly within Unified 
Classroom, and navigate to the next document or next student. 

In the next column, view whether the assignments have been graded, point totals, and, if 
available, links to online work. Click a column header to sort the list of assignments 
according to the column title. The Filter and Select options work the same as they do in the 
Students section. Use these to find or select specific assignments. 

To preview assignment attachments, use the document viewer to view many types of files, 
such as Word, Excel, and PowerPoint files, images, and videos directly within Unified 
Classroom. When you view a Word doc in the document viewer, there is a Translate feature 
to view the content in a different language. 

Create a New Assignment 

To create a new assignment: 

1. Click + in the top right corner of the window, available from most pages in Unified 
Classroom 
 

 
 
The Create Assignment window opens. 

2. Enter the name of the assignment, such as Chapter 1 Homework 

3. Enter a description, such as Answer all questions at the end of chapter 1 
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4. Once you click in the Description/Attachments field, the attachment paperclip icon 
appears. Click the icon to add any number of documents to an assignment, including 
Word documents, PowerPoint presentations, Excel files, pictures, and videos. The 
maximum file size for an attachment is 100 MB.  
 
You may wish to add a rubric for the assignment in the assignment description field 
so that students and parents can view the rubric. 
 

 
5. Open the Gradebook Category menu and select Homework as the category 

6. For the Student Work Type menu, use the default Assignment 

7. Check Submit Student Online Work 

8. In the Scheduling section, enter a due date for the assignment 

9. Determine when the assignment will be published using the "Display to Students and 
Parents" menu 

10. In the Scoring section, modify the score type and score entry points if they are 
different from the category defaults 

11. As appropriate, check Add Weighting to add additional weight and modify the total 
value  
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12. Leave the default Count in Final Grade checked to count the assignment in the 
final grade 
 
To exclude the assignment from the final grade, clear the check box. 

13. As appropriate, check Auto-Calculate Standard Scores (which may be grayed out) 

14. In the Class/Students section, click the edit icon 

15. Check all of the classes that this assignment applies to and click OK 

16. In the Standards area, click the edit icon to assign standards to the assignment 

17. Check the appropriate standards and click OK 

18. To complete the assignment, click Save and Close 

Duplicating Assignments 
Instead of creating another assignment that is similar to an assignment you have already 
created, duplicate the existing assignment. 

Edit the duplicated assignment information and click Save and Close. 

To duplicate an assignment previously created for use in another class: 

1. Click Grading 

2. Click Assignment/Activity List 

3. Roll your cursor over the assignment row and click the edit icon that appears on the 
right side of the row 

4. Click Save and Duplicate at the bottom of the Edit window 

5. Edit the duplicated assignment name by deleting the underscore and number that 
were appended to the end 
 
Assignment names must be unique within the term. 

6. Use the same description, category, due date, publication settings, score type, and 
score entry points as the original assignment, or modify the values as needed 

7. In the Class/Students section, click the edit icon 

8. Modify the class and student selections as necessary and click OK 

9. In the Standards section, if needed, select a new set of standards that are aligned to 
this assignment and click OK 

10. To save the duplicated assignment and close the Edit window, click Save and Close 

11. Verify that the duplicated assignment is present on the Assignment/Activities page 
for the appropriate class by locating the duplicated assignment in the list of 
assignments 

Modify or Delete an Assignment 

Once an assignment has been created, follow these steps to modify an assignment: 

1. Click Grading 

2. Click Assignment/Activity List 
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3. Roll your cursor over the assignment you wish to modify 
 
The edit icon appears at the end of the assignment row. 

4. Click the edit icon 

5. Make any required changes and then click Save and Close 

To delete an assignment, follow these steps: 

1. From the navigation menu on the Dashboard, click Grading 

2. Click Assignment/Activity List 

3. Click the assignment name 

4. Click the edit icon 

5. At the bottom of the Edit page, click Delete 

6. Click Confirm Delete 
 
When scores exist for this assignment, the warning message "You are removing 
student scores on this assignment" appears. Either cancel the delete function or click 
"Remove and Delete Scores." 

Reusing Successful Assignments 
Copy one, some, or all of the existing assignments in a selected term and class to other 
terms and classes using the Copy Assignments feature on the Scoresheet page. Use the 
existing due dates, a custom due date, or proportional due dates relative to the selected 
term. 

To copy assignments from a Semester 1 class to a Semester 2 class: 

1. Click Grading 

2. Click Scoresheet  

3. On the Scoresheet page, click the gear icon on the right 

4. Click Copy Assignments 

5. Under From, open the Term menu and select Semester 1 

6. Under From, open the Class menu and select the class from which you want to copy 
the assignments 

7. Under To, open the Term menu and select Semester 2 

8. Under To, open the Classes menu and select the class or classes to which you want 
to copy the assignments 

9. Under Copy Options, open the Due Dates menu and choose whether you want to use 
existing, relational, or custom due dates 

10. Under Choose the Assignments, check the box to the left of the Category heading to 
select all of the assignments, or check individual boxes next to the assignment 
names to choose a smaller selection 
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11. To complete the process, click Copy Assignments 
 
Be sure to edit the due dates of the copied assignments. 
 

 

Entering Evaluation Scores 
When entering scores, make sure to use the type of score that you set up when you created 
the assignment. For example, use numbers for points and percentages or letters for letter 
grades. 

There are many different ways to enter a single score for a single student. First click the 
scoring icon for an assignment in the Recent Assignments area. Click in the score cell for a 
specific student and enter a grade. 

If you’ve been working with a specific student and you're on the Student Detail page, add a 
score by clicking Edit Scores in the Recent Assignments area. 

And you can always navigate to either the Assignment/Activities or Scoresheet pages by 
selecting Grading from the navigation menu. 

To enter scores using the direct entry method: 

1. Click Grading 

2. Click Scoresheet 

3. From the Scoresheet page, enter a student’s assignment score by clicking in the cell 
where the student’s name intersects with the assignment name and then typing the 
score  
 
Navigate horizontally through the score columns by clicking the blue columns with 
left- or right-facing arrows at the end of the rows.  
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4. To work with a specific assignment, click the assignment name 
 
View the summary below the assignment name to see the selected assignment’s 
score type. 
 
In the summary, click Edit Assignment to edit the assignment details. Click Show 
More to view additional information, such as the associated grade and special codes 
scales. 
 

 
To view additional metrics for a selected assignment on the Assignments/Activities page or 
for all assignments on the Scoresheet page: 

1. Click the gear icon at the top of the page 

2. Click Show Metrics to view the mean, median, and mode statistics for the 
assignments or the aligned standards 

Using the Score Inspector and Flags 
While you can enter scores manually, use the Score Inspector to provide more details about 
the student’s performance, such as when a student has a missing or late assignment. Also 
use the Score Inspector to enter a comment about a student’s score.  

Your district leaders may have associated a special codes scale to the regular grade scale. If 
that is the case, you can click Codes in the Score Inspector and select a special code, such 
as INC, to score a student’s assignment. In some cases, you may also see other system-
generated icons that are related to standards grades. 

To open the Score Inspector, click in a score cell on the Assignments or Scoresheet pages.  

The following table provides brief explanations of the flags (score indicators) and other icons 
available on the Grading pages. 

Flag or Icon Description 

 

Indicates that an assignment was collected  

 

Indicates that an assignment is late 

 

Indicates that an assignment is missing 
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Flag or Icon Description 

 

Indicates that an assignment is exempt 

 

Indicates that an assignment wasn’t completed 
due to the student being absent 

 

Indicates that an assignment is incomplete 

 

Indicates that a comment was added 

 

Indicates that evidence exists for mastery that 
may differ from a student’s calculated standard 
score 

 

Indicates that the standard grade is auto-
calculated from the lower-level standards scores 

 

Indicates that the assignment score is used to 
auto-calculate the scores for the standards 
aligned to the assignment 

Hot Keys 

Use keyboard shortcuts, or hot keys, to enter score indicators quickly. 

Hot Key Code Description 

CO or (.) Marks an assignment collected 

LA or (*) Marks an assignment late 

MI or (/) Marks an assignment missing 

EX Marks an assignment exempt 

AB Marks an assignment incomplete due to student absence 

IN Marks an assignment incomplete 
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Filling Scores 

Use the Fill functions to either fill scores for one assignment for all of the students in a class, 
or to fill all assignment scores for one student. Scores will be filled in cells that do not 
already have scores. Additionally, use the fill scores functions to fill comments. 

To fill students’ scores for one assignment: 

1. For the selected assignment, click in a score cell on the Assignments/Activities or 
Scoresheet pages 

2. Enter the score or select the flag in the Score Inspector 

3. Click the Fill icon with the vertical arrows 

4. Save the scores 

To fill multiple assignment scores for one student: 

1. For the selected student, click in a score cell on the Assignments/Activities or 
Scoresheet pages 

2. Enter the score or select the flag in the Score Inspector 

3. Click the Fill icon with the horizontal arrows 

4. Save the scores 
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Marking Assignments 
Use one of two methods to score an assignment—score a single assignment from the 
Assignments page or score multiple assignments on the Scoresheet. 

Single Assignment 

To enter scores, flags, or comments for a single assignment, on the Dashboard, roll your 
cursor over the assignment name and then click the view scores icon that looks like a 
calculator. On the Assignments page, enter the students’ assignment scores in the Score 
column. If standards are aligned to the assignment, enter the standards scores in the 
standards columns. Use the arrow keys on your keyboard or the arrows at the top of the 
Score Inspector to move to different score cells. To save the scores, click Save Scores. 

If you navigate away from the page before saving scores that you’ve entered, a prompt will 
appear asking if you want to discard the changes or save them and continue. 

To view additional standards metrics for a selected assignment, click the gear icon at the 
top of the assignment page. Then click Show Metrics to view the mean, median, and mode 
statistics for the assignment and the aligned standards. 

Scoresheet 

To enter scores, flags, or comments for one or more assignments on the Scoresheet, click 
Grading and select Scoresheet. Also navigate to the Scoresheet for an individual class by 
opening the class selector menu and clicking the Scoresheet icon next to the class name. 
Click in a student’s score cell to enter a score using any of the options described above. Use 
the arrow keys on your keyboard or the arrows at the top of the Score Inspector to move to 
different score cells. To move across to the "next page" of the Scoresheet (the columns just 
outside of the visible area of the screen), click the blue columns with left- or right-facing 
arrows at the end of the rows. To save the scores, click Save. 

To view additional metrics for all of the assignments, click the gear icon at the top of the 
Scoresheet page. Then click Show Metrics to view the mean, median, and mode statistics 
for the assignments. 

Score a Single Assignment 

To enter scores, flags, or comments for a single assignment: 

1. Click Grading 

2. Select Assignment/Activity List 

3. Roll your cursor over the assignment row and click the view scores icon that 
resembles a calculator 

4. Click in a student’s score cell and type a score, such as 72 or C 
 
View the assignment summary above the list of students to see which score type to 
use. 

5. Click the Comment icon in the Score Inspector 

6. Enter a comment, such as Needs to turn work in on time 

7. Click the right-facing Score arrow in the Score Inspector to move to a standards 
score cell (if standards are aligned to the assignment) 
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8. Enter a standards score for the student 
 
View the assignment summary above the list of students to see which grade scale 
type to use. 

9. Save the scores 

Score Multiple Assignments 

To enter scores and flags for multiple assignments: 

1. Click Grading 

2. Select Scoresheet 

3. Click in a student’s blank score cell for the selected assignment and click the Exempt 
flag in the score inspector 

4. Click in another student’s blank score cell for the same assignment and click the 
Absent flag 

5. Now click in the first student’s blank score cell for another assignment and enter a 
score in the Score Inspector 

6. Click the vertical Fill icon to fill all of the blank score cells with the score you entered 
in the Score Inspector 

7. In the alert window that lists the number of scores that were filled, click Ok 

8. Click Save 

When you delete or edit a score, a small gear icon appears next to the values in the 
student’s Grade column because they are being edited. Once you save the changes, the 
student’s grades will be recalculated using the new score. 

Note, if you see unexpected grades on the Scoresheet, have your PowerSchool 
administrator verify the accuracy of the course grade scale. 

Copying Scores and Grades 

As a busy teacher, you sometimes make mistakes, like entering scores for the wrong 
assignment in your gradebook. Or, you may have students switch between two classes that 
you teach. Fix score entry mistakes or transfer scores by copying and pasting scores or 
grades from one assignment to another, or from one class to another class with the same 
students in different reporting terms. Use the Assignments, Scoresheet, or Standards 
Grades pages to copy and paste scores or grades. However, keep the following rules in 
mind: 

• You cannot replace scores or grades that use a different score type than the original 

• When pasted to a column with different grade scales or total points, scores and 
grades are not converted to the new grade scales or total points 

• If the list of students is different between the original assignment scores and the 
assignment being copied to, only scores for students who are in both classes will be 
updated 

• You cannot paste into the assignment score column on the single assignment scoring 
page when an assignment is set to auto calculate standard scores 

• You are unable to copy scores and grades to a locked term 
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To copy and paste scores or grades: 

1. Sign in to Unified Classroom and select a class 

2. Click Grading 

3. Click Scoresheet 

4. Click the assignment score column heading 

5. Choose Copy 

6. Locate the assignment you wish to paste to and click the score column header 

7. Then choose Paste 
 
All updated scores and grades are highlighted. 

8. Save the scores 

Encouraging Students 
As you enter scores or flags for assignments, use comments to record specific details about 
student performance. Add comments manually or choose comments from the comment 
bank. Click the star next to a comment in the bank to set it as one of your favorite 
comments.  

To fill comments, enter a comment for one student and click the Fill icon. Then choose to fill 
comments only or to fill scores, flags, and comments.  

When you use the fill functions to fill comments that include the student’s name or any 
gender pronouns, the system detects this and you have the choice of applying the smart 
text to the comment for each student or using the original text. For example, if you enter a 
comment for one student that says, “James completed all assignment tasks,” and fill the 
comment for other students, select Use Smart Text, so that each student’s name will be 
personalized in the resulting comments. 

Add an Assignment Comment 

To add an assignment comment: 

1. Click Grading 

2. Click Scoresheet 

3. From the Scoresheet page, click in the cell where the student’s name intersects with 
the assignment name 

4. Click the Comment icon in the Score Inspector 

5. Enter the comment Nice work! in the text box 

6. Click in a cell where another student’s name intersects with the assignment name 

7. Click the Comment icon in the Score Inspector 

8. Click Comment Bank and select a comment by clicking the + sign next to it 

9. Click Save 
 
A blue Comment icon appears in the student’s score cell. 

10. Click the icon to read the comment 
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Add Personal Comments to the Comment Bank 

Use the Comment Bank settings page to add personal (teacher-created) comments to the 
comment bank to use when scoring assignments or adding final grade comments for report 
cards. Use smart text options to include names and pronouns in comments to personalize 
the comments for individual students. 

Also use the Comment Bank settings page to edit or delete personal comments, or to 
identify your favorite personal or district comments. To mark a comment as a favorite, click 
the star next to a comment on either the My Comments or District Comments tab. Your 
favorite comments will appear at the top of the list of comments in the Score Inspector. 

To add a personal comment to the comment bank: 

1. Open the user menu and click Settings 

2. Click Comment Bank 

3. On the My Comments tab, click Add 

4. Enter a comment code, such as 01 
 
Comment codes are limited to 10 characters. 

5. Enter a comment category, such as Study Habits 
 
Comment categories are limited to 30 characters. 

6. To mark this comment as one of your favorites, check Favorite 

7. Open the Insert Smart Text menu and choose <first name> to insert it in the 
Comment field 

8. Enter the rest of the comment after the smart text, such as consistently 
completes homework on time 
 
Comments are limited to 500 characters. 

9. Click Save 
 
Your personal comment is listed on the Comment Bank setting page and will appear 
in the comment bank in the Score Inspector. 
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Calculating Term Success 
Final grades are updated automatically throughout the term as you enter assignment scores 
in Unified Classroom. When the term comes to a close, however, you may have additional 
tasks to perform before submitting grades for report cards to make sure that your final 
grades are accurate. For example, you may have to enter standards grades, modify 
individual scores, or enter citizenship grades. Occasionally, you may also need to modify a 
student’s final grade in a course based on effort, participation, or other performance factors.  

To work with final grades, click Grading and then Grades. Access the different areas of the 
Grades page using the Quick Menu—the arrow next to the heading at the top of the Grades 
pages.  

 
Click Traditional to view the traditional grades for an entire class, along with a summary of 
how many absences, tardies, missing assignments, late assignments, and incomplete 
assignments each student has. To edit the final grades, click in the first column and edit the 
data in the Score Inspector. The grades correspond to the reporting term you select in the 
term menu in the top-right corner of the page. To see grades for a different term, open the 
term menu and select a reporting term code. 

Open the Quick Menu and click Standards to view or edit the standards final grades for an 
entire class for the selected term. Use the Standards page when preparing for report cards 
to quickly evaluate or modify your students' standards grades. To edit a final grade for a 
student, click in the grade cell for a standard and edit the data in the Score Inspector. To 
evaluate the supporting assignment scores for a standards grade, in the Score Inspector, 
click the graph icon to open the view-only standards progress graph for the selected 
standard and student. 

The progress graph shows how the student performed on the standard over a period of 
time. Use the arrows to the left and right of the standard ID in the Score Inspector to view 
graphs showing the selected student’s performance on other standards assessed this term. 
To open the student's Standards Progress page to change the supporting assignment 
scores, click Show More at the top of the graph. (Learn more about the Standards Progress 
page in the Analyzing Performance section of this course.) Click the graph icon in the Score 
Inspector again to close the progress graph. To view additional standards metrics, click the 
gear icon at the top of the Standards page and then select Show Metrics to view the 
mean, median, and mode statistics. 
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If you see the Professional Judgment Indicator on the Standards page, note the student’s 
name and the standard label. Then click Students, and select the view icon for the student 
you wish to work with. On the Student Detail page in the Standards Progress area, click 
Edit Grades. Locate the standard on the student’s Standards Progress page. Scroll, if 
necessary, to see the term that features the indicator. Click the assignments icon at the 
right to view a graph of all scores on assignments aligned to that standard. You will 
probably see that one of the most recent scores doesn’t seem to fit the pattern the student 
displayed through the rest of the term. If his performance on that assignment does not 
accurately reflect his mastery of that standard, modify the final grade for the standard. 

Return to the Grades page, open the Quick Menu, the menu at the top of the page, and 
select Comment Verification to view or add final grades comments. Use this page when 
you are getting ready to complete grades for report cards. To add or edit a comment, click a 
student’s final grades and click the Comment icon in the Score Inspector. Add comments for 
additional students and click Save. 

Open the Quick Menu and select Category Totals to view a summary of students’ grades 
by assignment category. Use category totals to assess how students performed in one 
assignment category versus another, or to analyze the difficulty of one category type versus 
another. For example, if students received significantly lower scores on assignments in the 
Homework category than in the Test category, you might revisit the homework assignments 
and analyze their difficulty. To view additional metrics, click the gear icon at the top of the 
page and then select Show Metrics to view the mean, median, and mode statistics. 

To view and work with students’ final grades from all reporting terms, open the Quick Menu 
and click All Reporting Terms. Each column represents a reporting term. The column that 
corresponds to the current term is highlighted. Click a student’s final grades for a reporting 
term and use the Score Inspector to modify scores or add comments. 

Click Save after you make any grading changes. When you change a final grade manually, 
the cell that contains the student’s final grade will have a small triangle in the upper-left 
corner, indicating that the grade has been modified manually. The Score Inspector will 
display both the modified grade and the original calculated grade. To revert to the 
calculated grade, click the Undo icon in the Score Inspector. 

To work with the final grades for students in another class, click the name of the currently 
selected class at the top of the gradebook window and choose a different class. 

Modify a Final Grade 

To modify a final grade: 

 Click Grading > Grades 
 
Ensure that Traditional is selected. 

 Click a student’s final grade 

 In the Score Inspector, edit the student’s grade  
 
For example, change a letter grade of A- to A, and a percentage of 91 to 94. 
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 Click Save  
 
Notice that the student’s final grade cell has a small triangle in the upper-left corner, 
which indicates that the grade has been modified manually. 
 

 
 Open the Quick Menu and select Standards 

 Click a standards grade for the same student and edit it  
 
For example, change a score of 3 to 4 

 Click Save 
 
To revert to the calculated grade, click the Undo icon in the Score Inspector. To view 
additional standards metrics, click the gear icon at the top of the page and then 
select Show Metrics to view the mean, median, and mode statistics. 

Recalculating Final Grades 
Although final grades in Unified Classroom are calculated automatically, you can force a 
recalculation, if necessary. Use the recalculate tool after making significant changes to 
grades, such as adding multiple assignment scores for students who transferred from 
another class. Also, recalculate grades when your PowerSchool administrator changes a 
setting that affects grading, such as the grade calculation formula. 

To use the recalculate tool to recalculate traditional and standards final grades: 

1. From the navigation menu, click Grading 

2. Click Grades 

3. From the Quick Menu, select Traditional 

4. Click the gear icon in the top right  

5. Click Recalculate Final Grades 

6. Select the classes for which you are recalculating grades 

7. To recalculate traditional grades, check Traditional Final Grades 

8. To recalculate standards scores, check Standards Final Grades 

9. Click Recalculate 
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Entering Citizenship Scores 
If your school doesn't track behavior through standards, then your district leaders may 
enable citizenship score entry and set up a citizenship scale that includes codes like S for 
Satisfactory or N for Needs Improvement for you to use. If your school policy requires you 
to enter citizenship scores for your students, use the Traditional grades page to do so. 

Enter Citizenship Scores 

To enter citizenship scores: 

1. Click Grading > Grades 
 
Ensure that Traditional is selected. 

2. Click in a student's cell in the Citizenship column 

3. In the Score Inspector, select a citizenship score, such as S 

4. Click Save 

 

Awarding Variable Credit 
If you teach at a school that has an alternative education program or any sections in which 
students can earn variable credit hours for a course, your school administrator can set up 
PowerSchool so that you can enter variable credit for students in Unified Classroom. 

Using variable credit, teachers can specify how much credit each student attempted 
(potential credit) and how much credit each student is awarded (earned credit), regardless 
of the credit hours specified for the course or the grade the student earned for the class in a 
term. 

Once variable credit is enabled for one or more of the sections you teach, use the 
Traditional grades page to enter variable credit. Click Grading > Grades and use the 
default Traditional. If your school's transcripts include both awarded and attempted credit, 
you'll see two columns on the Traditional page for entering the variable credit values. If 
transcripts include only awarded credit, then you'll see only one column for entering the 
credit values in Unified Classroom. 

In some cases, students who earn traditional credit hours and students who earn variable 
credit hours are enrolled in the same sections. For example, students may earn variable 
credit in a course if the course requirements have been partially satisfied due to interrupted 
attendance in the course because of mid-semester enrollment, transfer, or significant 
absences. In these classes, teachers enter the variable credit for only those students for 
whom variable credit is applicable. 

Award Variable Credit 

To enter awarded and attempted variable credit: 

1. Click Grading 
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2. Click Grades 

3. Open the grades menu and click Traditional 

4. Click in a student's cell in the Awarded column 

5. Enter the number of credits the student earned, such as .5 

6. Click in the same student's cell in the Attempted column 

7. Enter the number of credits the student attempted, such as 1 

8. Click Save 

Note: If your school's transcripts include only awarded credit, then you'll see only one 
column for entering the credit values on the Traditional Grades page. 

Submitting Final Grades 
At the end of the term, notify your school’s PowerSchool administrator that you have 
finished entering the scores for the term and that final grades are ready to be stored. Or, if 
you are not yet done with final grades and the final grade deadline is near, send a status 
comment to your PowerSchool administrator, such as Final grades will be done by 
Friday.  

Your PowerSchool administrator will see the final grade statuses of your classes, along with 
any status comments you've submitted, by running the Section Readiness report in 
PowerSchool. 

Keep in mind that this function does not prevent a teacher from making modifications. A 
teacher can sign off and then go back and modify grades or comments. 

To enter your final grade status, from the navigation menu, click Grading. From the 
Grading menu, click Grades. At the bottom of the Traditional, Standards, or Comment 
Verification pages, click Final Grade Status. 

To add a note about the grade status: 

1. In the navigation menu, click Grading 

2. From the Grading menu, click Grades 

3. At the bottom of the Traditional, Standards, or Comment Verification pages, click 
Final Grade Status 

4. Enter a note to update the status 

5. Click Save  

Submit Final Grades 

To indicate that final grades are ready for one of your classes: 

1. In the navigation menu, click Grading 

2. From the Grading menu, click Grades 

3. At the bottom of the Traditional, Standards, or Comment Verification pages, click 
Final Grade Status 

4. Indicate that final grades are complete by checking the check box 
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5. Click Save 
 

 

Understanding Locked Reporting Terms 
At the end of a reporting term, your PowerSchool administrator may choose to lock the 
reporting term to prevent changes to grades so that the grades in teachers' gradebooks 
remain the same as the grades that have been stored in PowerSchool and included on 
report cards. Your PowerSchool administrator will define the dates on which reporting terms 
will be locked. Once a reporting term is locked, you will not be able to change final grades, 
assignment scores, or assignments that have been scored. Additionally, if you recalculate 
final grades, grades in any locked terms will not be recalculated. 

If your school or district leaders decide to lock reporting terms, you will see warning 
messages at the top of Unified Classroom pages, such as the Scoresheet and Traditional 
Grades pages.  

• Before the reporting term is locked, you will see a warning message indicating when 
the reporting term will be locked  
 
For example, you may see a message that says the reporting term will be locked in 
five days. Be sure to complete final grades before the end of the lock date.  

• Once a reporting term has been locked, you will see a message indicating that the 
term is locked 

If you attempt to score an assignment or a standard aligned to an assignment that has a 
due date in a locked term, you will also see a message in the Score Inspector indicating that 
the score is locked. 

What if you need to correct a final grade after a term is locked? If you need to change 
assignment scores or final grades after a reporting term has been locked, contact your 
PowerSchool administrator. Your administrator can temporarily unlock one or more of your 
classes so that you can make the necessary changes. 

Personalizing Unified Classroom 
Click the teacher's name at the bottom of the navigation menu to open the user menu and 
access your profile, update settings, and to sign out. 
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User Menu Purpose 

 

Manage your Unified Classroom accounts 

 

Teachers are able to modify several settings such as 
class descriptions, display settings, and assigning 
alternate grade scales to individual students 

 

Close your current Unified Classroom session 

Viewing and Adding Class Descriptions 
The gradebook includes view-only details about each class you teach, such as the course 
name, course number, section number, period, term, start date, end date, and associated 
grade scale. Add more details about the class—such as a description or the syllabus—that 
will be visible in the student and parent portals. Or customize the name of the class. 

 
To customize a class name and add a description to your classes: 

1. On the Dashboard, click the user menu 

2. Click Settings 

3. Click Class Descriptions 

4. Select a class from the class list 
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5. In the Custom Class Name field, enter a new name for the class such as 1st Period 
Biology 
 
Note that you will be the only one who can see the custom class name. Students and 
parents will not see it. 

6. Enter a class description in the Class Description field 

7. Scroll down the page and click the arrow to the left of another class name to open 
the details pane and add a custom name and description 

8. When you are done making changes, click Save 

Setting Up Display Preferences 
Customize the display settings to control the scale of your Unified Classroom text and how 
class names appear in Unified Classroom—by period and day or by section number. 
Additionally, define whether or not to show standards and traditional grades. By default, 
standards and traditional progress information is visible.  

To display just traditional progress on the Dashboard, clear the "Show Standards Pages and 
Links" check box. Clearing this check box removes additional standards features within 
Unified Classroom. To display just standards progress on the Dashboard, clear the "Show 
Traditional Grades" check box. 

Modifying Display Settings 

To modify your display preferences in Unified Classroom: 

1. At the bottom of the navigation menu, click the user menu 

2. Click Settings 

3. Click Display Settings 

4. To increase the size of the text and page elements in Unified Classroom, open the 
Scale View menu and choose Medium or Large 
 
Small is the default size. 

5. Open the "Display and Sorting" menu and select an option, such as Section 
Number (sort by Course Name), to change the way class names appear  

6. Check Show Traditional Grades to view traditional grades in Unified Classroom 

7. Then from the “Values to Show in the Traditional Grade Column” menu, select the 
types of grades you want to see, such as Grade, Percent, and Points 
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8. Check Show Standards Pages and Links to use the standards grading features 
and to display standards information in Unified Classroom 

9. Check Show Standards on Assignments to show standards aligned to 
assignments  

10. To make the auto-calculation of standards scores from assignments scores the 
default setting when you create a new assignment, choose New Assignments Start 
Checked from the “Auto-Calculate Assignment Standards Scores Initial State” menu 
 
Making this selection will cause the “Auto-Calculate Assignments Standards Scores” 
check box to be selected by default when you create an assignment. To view the 
setting when creating a new assignment, navigate to the Standards tab, select the 
standards that are aligned to the assignment, and click the Show Selected Standards 
tab. 

11. To change the sort order of the Traditional and Standards navigation links in the 
Grading menu and Quick Menu, open the Navigation Links Sort Order menu and 
choose Standards, Traditional 
 
The default setting is Traditional, Standards. 

12. To display the Professional Judgment Indicator on the Standards and Standards 
Progress pages, check Show on Grading: Standards and Show on Students: 
Standards Progress 

13. Under Student Names, use the Display menu to define how students’ names will 
appear, such as by first, then last name 

14. Use the “Sort Students by” menu to choose how to sort the lists of students, such as 
by first name 

15. To view new students’ names at the bottom of class lists, check Add newly 
enrolled students to the bottom 

16. To conceal the names of pre-registered students from class lists, check Hide pre-
registered students 

17. Click Save 

Teacher-Level Grading Preferences 
Administrators may choose to set up the grading preferences at the district or school level 
for all teachers. However, if they are permitted to do so by their district and school leaders, 
teachers may define some of the grade calculations for the classes they teach. Provided you 
have permission to do so, set up the grade calculations for one class. Then save time by 
copying the traditional grade calculations across classes and reporting terms. 

Traditional Grade Calculation Settings 

To define traditional grade calculations in Unified Classroom, open the user menu and click 
Settings. Then click Traditional Grade Calculation. 

The Traditional Grade Calculations page lists all of your classes, along with the calculation 
formula type for each reporting term. If a grade calculation formula is not defined, the 
default calculation type is Total Points. 
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Standards Grade Calculation Settings 

To define standards grade calculations in Unified Classroom, open the user menu and click 
Settings. Then, click Standards Grade Calculation. 

The Standards Grades Calculations page lists all of your classes, along with the default 
calculation method for how standards grades are calculated from assignment standards 
scores. 

Modifying the Calculation Method 

To define a traditional grade calculation for a class: 

1. At the bottom of the navigation menu, click the user menu 

2. Click Settings 

3. Select Traditional Grade Calculation 

4. To see the grade calculations for all of the classes, click Expand All 

5. For one of the classes in the list, click the Edit icon next to the first reporting term 

6. To calculate the overall class grade using the formula, verify that Calculate Overall 
Class Grade is checked 

7. Open the Type menu and choose a calculation type, such as Category Weighting 

8. Open the Attribute menu and select a category, such as Homework 

9. To define the weight of the selected category, enter a value in the Weight field, such 
as 2 (for 20%) 

10. To include another category, click the + sign 

11. Open the Type menu and choose Category Weighting 

12. Open the Attribute menu and select a different category, such as Quiz 

13. To define the weight of the selected category, enter a value in the Weight field, such 
as 3 (for 30%) 

14. Repeat steps 10–13 to set up weighting for a couple more categories 
 
Use weight values that will make the values in the Percent columns add up to 100%. 
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15. To save the grade calculation, click Save 
 
Set up the grade calculations for the remaining reporting terms. If you do not have 
access to edit the grade calculation preferences, follow your school and district 
policies or contact your PowerSchool administrator. 
 

 

Copying Traditional Grade Calculations 

Once you have set up your grade calculations for a class, save time by copying the settings 
to another reporting term within the same class or to another class. 

To copy traditional final grade calculations: 

1. At the bottom of the navigation menu, click the user menu 

2. Click Settings 

3. Select Traditional Grade Calculation 

4. In the upper-right corner of the Traditional Grade Calculations page, click the gear 
icon 

5. Select Copy Traditional Grade Calculations 

6. At the top of the Copy Final Grade Calculations window, select Within A Class to 
copy the settings from one reporting term to another within the same class 

7. In the From area, open the Class menu and choose the class from which you want to 
copy the calculations 

8. In the From area, open the Reporting Term menu and choose S1 as the term from 
which you want to copy the calculations 
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9. In the To area, open the Reporting Term menu and choose S2 as the term to which 
you want to copy the calculations 
 
If you are changing traditional grade calculation settings for the target class and 
want to recalculate any existing grades, check Recalculate Final Grades. 
 

 
10. Click Validate  

11. Review the summary to ensure that you are copying the correct settings, then click 
Copy 
 
The alert at the top of the window indicates that the settings were copied 
successfully. 

To define standards grade calculations: 

1. At the bottom of the navigation menu, open the user menu 

2. Click Settings 

3. Select Standards Grade Calculation 

4. Define how standards grades will be calculated from assignment scores by default, 
for example, choose Most Recent Scores  

5. Define the number of recent scores to include in the calculation and their relative 
weighting by clicking the Edit icon, choosing the number of scores, and modifying the 
values in the Weight column 

6. To automatically calculate higher-level standards grades from lowest-level standards 
grades, check Auto-Calculate 

7. Select the metric that will be used in the calculation, such as Mean 
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8. Click Save 
 

 

Assigning an Alternate Grade Scale 
District or school administrators may make alternate traditional grade scales available for 
teachers and administrators to assign to individual students. If you have permission to do 
so, assign alternate grade scales to students so that you can grade them using a traditional 
grade scale that's different from the scale assigned to the class. For example, a student 
may have an Individualized Education Program (IEP) that specifies the use of an alternate 
grade scale, such as a Pass/Fail scale or one that does not include a failing grade. Use the 
Student Grade Scales page in Unified Classroom to assign the alternate scale to the student. 
Also use the Student Grade Scales page to view, modify, or remove grade scales assigned 
to individual students. 

When a student has been assigned an alternate grade scale, the Scoresheet will include a 
gold triangle in the name cell for that student.  

 
Additionally, the Score Inspector will indicate that the student's final traditional grade is 
being calculated using the alternate student grade scale. 

Keep in mind that new assignment scores you enter for the student will be based on the 
alternate scale. Although you can't recalculate previously entered scores for individual 
assignments, you can recalculate the student's final traditional grade by following the steps 
for recalculating final grades in this course. 
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Assign an Alternate Grade Scale to an Individual Student 

To assign an alternate grade scale to an individual student: 

1. At the bottom of the navigation menu, open the user menu 

2. Click Settings 

3. Click Student Grade Scales 

4. Locate the section the student is enrolled in and click the arrow next to the section 
name 

5. To add a student grade scale, click Add 

6. From the Choose Grade Scale menu, select the alternate grade scale 

7. Check the box to the right of the student's name  

8. Click Save 

9. To confirm the change, click Save Changes 
 
New assignment scores that you enter for the student will be based on the alternate 
scale. To update previously entered scores, recalculate final grades. 

10. On the Student Grade Scales page, view, modify, or remove grade scales assigned to 
individual students 

Communicating with Students and Parents  
You can use several tools within Unified Classroom to keep both students and parents 
informed. Above sections of this document discuss how to add and review events using the 
Calendar page.  

Within Unified Classroom, you can also use the Class Pages feature to create public-facing 
pages for posting information, sharing resources, and to facilitate discussions. Use the 
Reports feature within the Analysis section to print reports to send home with students. 

Now learn how to create new activity feed items and message students and parents using 
the Communications section of the navigation menu.  

Sharing Class Activities 
Use the Activity Feed section to communicate with students and parents. Recent posts 
appear in the Activity Feed window. Access the Activity Feed area on the Dashboard or click 
Communication on the navigation menu and then click Activity Feed. 

To add a new message, click in the text field and type a message. In addition to several 
formatting options, your messages can include tables, links, and images. You can also add 
an assignment or a document to a post. Activity feed posts are viewable by the selected 
classes and by the contacts of those students within the classes who have active web access 
accounts. 
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On the Dashboard, to see previous posts, click View More.  

Create a New Post 

To add a new post to remind students that an assignment is due tomorrow: 

1. On the Dashboard, in the Activity Feed, click Post 

2. In the Post field, enter an announcement, such as Group projects are due 
tomorrow!  

3. Click the Attach Assignment icon 

4. Scroll through the assignments list and check the assignment you wish to attach to 
the post 

5. Click OK 

6. In the Post To area, click the gear icon 

7. Check the check box next to each class in which the assignment is due tomorrow 

8. Click OK 

9. Click Post 

Messaging Students and Parents 
Use Messaging to communicate with a student or the student's parents in a user-
friendly, modern chat format. Students and parents can also reply to a teacher’s chat and 
send the teacher messages. When a new message is sent, teachers, students, and parents 
receive a notification within Unified Classroom, as well as an email notification. 
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Send a Message 

Send a message to a student and then to a parent of another student in the same class: 

1. Open the class selector menu and select a class 

2. Click Communication 

3. Click Messages 

4. Select a student from the list 

5. In the default Message Student tab, enter a note in the message field 

6. Click Send 

7. Next to Participants, click the + sign 

8. Enter the beginning of the student’s name whose parents you wish to contact and 
then select the student from the list that appears 

9. Click Message Parent 
 
When you message a parent, all of the contacts associated to the selected student 
with an active web access account will receive your message. 

10. Enter a note in the message field and click Send 

 

 

Glimpsing What Your Students See 
Just like with PowerSchool, districts and schools may choose to give students and parents 
access to the Unified Classroom Student and Parent Portals. With these portals, students 
and parents can use many of the same features as teachers. 
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Students and parents use the same username and passwords from PowerSchool Student 
and Parent Portals to sign in to Unified Classroom. Once signed in, they can view grades and 
attendance, access class pages, communicate with their teachers, and submit assignments. 

 

Finding Help in Unified Classroom 
To access step-by-step directions, videos, and training workbooks, click the help icon (which 
looks like a question mark) in the top right corner of the Dashboard, and then click Help 
Center. Teacher Help opens in a new browser tab or window so you can keep it open while 
using Unified Classroom and then close the tab or window when you are done. 

In addition to help navigating Unified Classroom, use the help icon or the Teacher Help page 
to: 

• Share your screen with a support agent during normal business hours to ask for help 
from the Support Team using Live Assist 

• Review frequently asked question in the FAQ section 

• Create a support ticket (an agent will follow up with you within one business day) 


